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4. ESTIMATIVA DE EVAPOTRANSPIRAÇÃO NO ESTADO 
DE MINAS GERAIS, BRASIL 

By: Elizabeth Ferreira1, Antonio Augusto Aguilar Dantas2, Alfredo Gabriel Garcia3 
 
A Universidade de Lavras foi fundada em 1908 como Escola Agrícola de Lavras, em 1938 foi renomeada Escola de 
Agricultura de Lavras; foi federalizada em 1963 e em 1994 tornou-se a Universidade Federal de Lavras, UFLA. 
Desde então tem estado comprometida com fornecer e alimentar o desenvolvimento e expansão contínuos dos 
serviços à sociedade. A força e a grandeza da UFLA pode ser medida pela sua estrutura presente e perspectivas 
futuras. A instituição está organizada em 17 departamentos didático-científicos, que atuam em diferentes áreas do 
conhecimento. A UFLA prepara mais de 5600 estudantes nos seus 30 cursos de graduação (23 presenciais e 7 a 
distância). Há mais do que 1500 alunos de pós-graduação, distribuídos em 20 cursos de mestrado e 18 de doutorado. 
No programa de ensino a distância há mais de 5000 estudantes de todos os estados brasileiros e do exterior. As 
projeções da UFLA são de 15000 estudantes matriculados até o ano de 2012. Para obter mais informações veja: 
http://www.ufla.br/en. 

4.1. Introdução 
A evapotranspiração (ET) é o termo usado para descrever a quantidade de água efetivamente cedida da superfície da 
terra para a atmosfera. ET é uma componente importante do ciclo hidrológico, fazendo da sua quantificação precisa 
uma necessidade para o cálculo do balanço de água no solo, para a detecção de condições de estresse hídrico, para o 
uso como variável de entrada em modelos quantitativos de colheita, ou para outras aplicações. O censo de 2006 do 
Instituto Brasileiro de Geografia e Estatística (IBGE) revelou que aproximadamente 5.2 milhões de estabelecimentos 
agrícolas ocupam 36,75% do território nacional (IBGE, 2006). Destes estabelecimentos, 6,3% reportaram o uso de 
irrigação, perfazendo um aumento de 39% com relação ao número averiguado no censo de 1995, significando ainda 
um aumento absoluto de 1.3 milhão de hectares. A área irrigada, 4.45 milhões de hectares (7,4% da área total), 
ocupada por cultivos temporários ou permanentes, conta com as seguintes formas de distribuição da água: 24% da 
área é irrigada por alagamento, 5,7% por sulcos, 18% por pivô central, 35% por método de aspersão, 7,3% por 
métodos localizados de fornecimento de água e 8,3% por outros métodos. Minas Gerais (586.528,293 km2 e 
população de 20.595,499 pessoas) é o estado brasileiro com o maior número de estabelecimentos (48.39 mil) usando 
alguma técnica de irrigação. Desde o início de 2011 até agora foram identificados um total de 3789 pivôs centrais em 
Minas Gerais (Ferreira et.al. 2011). Um dos principais problemas da agricultura irrigada é a quantificação correta das 
necessidades hídricas das culturas. A estimativa da evapotranspiração a partir de dados de sensoriamento remoto é 
uma forma possível para se fazer esta quantificação, especialmente para grandes áreas, já que os métodos tradicionais 
que utilizam informações meteorológicas coletadas em solo são capazes de representar apenas pontos no espaço 
geográfico. 
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4.2. Objetivo da Aplicação 
O objetivo desta aplicação é estimar a Evapotranspiração (ET) diária usando o Modelo de Sistema de Balanço 
Energético de Superfície (Surface Energy Balance System, SEBS, Model) para conhecer o padrão de ET sobre áreas 
irrigadas por pivôs, no estado de Minas Gerais, Brasil, usando ILWIS e a caixa de ferramentas de GEONETCast, 
com dados obtidos via GEONETCast e DevCoCast. 

4.3. Metodologia  
Primeiramente é apresentada uma breve revisão sobre o Modelo SEBS. Su (2002) indica que o SEBS exige como 
entrada três conjuntos de informações. O primeiro conjunto consiste no albedo da superfície terrestre, a 
emissividade, temperatura, fração da cobertura vegetal, índice de área foliar, e a altura da vegetação (ou a altura de 
rugosidade). Quando a informação sobre a vegetação não está explicitamente disponível, o NDVI pode ser usado 
como substituto. Estes dados de entrada podem ser derivados de dados de sensoriamento remoto em conjunção 
com outras informações sobre a superfície e interesse. O segundo conjunto de informações inclui a pressão do ar, 
temperatura, umidade e velocidade do vento a uma altitude de referência, e pode ser extraída de um modelo 
meteorológico de grande escala. Para aplicações pontuais, esta altitude de referência é o da medida dos parâmetros 
meteorológicos, já para aplicações regionais é a altura da camada limite planetária. O terceiro conjunto de dados 
inclui a radiação solar descendente, e a radiação de onda longa descendente. que podem ser medidas diretamente, 
obtidas através de rodadas de modelo ou por meio de outro tipo de parametrização.  
De acordo com Su et.al. (2005), o Modelo SEBS (Su 2002) foi desenvolvido para estimar os fluxos de energia de 
superfície e a fração evaporativa usando dados de sensoriamento remoto em conjunto com informações 
meteorológicas em escalas que dependem dos dados de entrada. SEBS consiste em vários módulos separados para 
estimar a radiação líquida e o fluxo de calor no solo, e para particionar a energia disponível (RN-G0) em fluxos de 
calor sensível e latente, como apresentado na equação 1: 
 

Rn - G0 = H+ λ E  (eq 1) 
Where: Rn: a radiação líquida; 

G0: o fluxo de calor no sol; 
H: o fluxo de calor sensível; 
λ E: o fluxo de calor latente. 

 
SEBS estima a radiação líquida com base no balanço radiativo. O outro componente envolvendo a energia disponível 
é o fluxo de calor no solo. Na ausência de medidas diretas do fluxo de calor no solo, como em aplicações de satélite 
ou em escala grande ou regional, formulações empíricas, baseadas na radiação líquida e na fração de vegetação, são 
usadas para estimar o fluxo total de calor no solo para a área. A variável remanescente independentemente estimada 
pelo SEBS é o fluxo de calor sensível (H), resolvido usando uma combinação de três equações usando a velocidade 
do vento e a velocidade de atrito. No SEBS, o modelo das saídas de calor sensível e latente é também limitado pela 
consideração de condições de seca-limite e umidade-limite, que dão os limites superior e inferior da estimativa do 
fluxo de calor sensível. Maiores detalhes sobre as técnicas usadas para separar os fluxos de calor sensível e latente da 
energia disponível podem ser encontrados em Su (2002). O Modelo SEBS está implementado no ILWIS e no BEAM 
(Wang et.al., 2008). A versão utilizada aqui para o plug-in ILWIS SEBS é a 1.1. Note que informações adicionais 
sobre SEBS também estão disponíveis a partir do menu principal do ILWIS> Selecione a opção “Help” e selecione 
“SEBS Help”. 

4.4. Dados de entrada   

4.4.1. Dados locais / regionais (in-situ)  
Os dados de entrada (in-situ) para o modelo SEBS são: a média diária dos ventos a 2m (m/s), a razão de mistura 
(kg/kg), a temperatura diária (oC), a radiação solar líquida na superfície do cultivo (W/m2). Estes dados são obtidos 
de estações meteorológicas de superfície, localizadas nos seguintes municípios mineiros: Araçuaí, Araxá, Bambuí, 
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Barbacena, Belo Horizonte, Poços de Caldas, Cambuquira, Capinópolis, Caratinga, Cataguases, Conceição do Mato 
Dentro, Coronel Pacheco, Curvelo, Diamantina, Espinosa, Florestal, Governador Valadares, Ibirité, Itamarandiba, 
Januária, João Monlevade, João Pinheiro, Juiz de Fora, Lavras, Machado, Montes Claros, Oliveira, Passa Quatro, 
Patos de Minas, Pedra Azul, Pirapora, Pompeu, Salinas, São João del-Rei, São Lourenço, Sete Lagoas, Teófilo Otoni, 
Uberaba and Viçosa. Estes dados foram extraídos do CD “Normais Climatológicas do Brasil 1961-1990”. Os 
arquivos locais e regionais específicos necessários para este exercício são listados abaixo:  

• DEM (obtido de http://eros.usgs.gov/#/Find_Data/Products_and_Data_Available/gtopo30_info): 
GTOPO30_Minas (camada de  mapa do ILWIS) 

• Dadis Climáticos (CD encomendado de http://www.inmet.gov.br/): 
Station_MG.txt 

• Fronteiras (obtidas de http://www.geominas.mg.gov.br/): 
Fronteira (ILWIS map layer) 
Municipalidades (camada de mapa do ILWIS)  
pivots_MG (camada de mapa do ILWIS) (dos autores) 

4.4.2. Dados do GEONETCast-DevCoCast 
Os produtos GEONETCast-DevCoCast são obtidos do LSA SAF para a janela da América do Sul. Os produtos são: 
albedo, DSSF, LAI, LST, FVC, e o produto diário de Evapotranspiração. Por fim, o SPOT Vegetation S10 
Maximum Value Composite NDVI foi obtido do DevCoCast. Os arquivos necessários para este exercício estão 
listados abaixo: 

• Produtos Landsaf (obtidos de https://landsaf.meteo.pt/): 
S-LSA_-HDF5_LSASAF_MSG_ALBEDO_SAme_201005020000.bz2 
S-LSA_-HDF5_LSASAF_MSG_FVC_SAme_201005020000.bz2 
S-LSA_-HDF5_LSASAF_MSG_LAI_SAme_201005020000.bz2 
S-LSA_-HDF5_LSASAF_MSG_DSSF_SAme_201005021500.bz2 
S-LSA_-HDF5_LSASAF_MSG_LST_SAme_201005021500.bz2 
ET_Minas_geo (ILWIS map layer) 

• Produto SPOT Vegetation (obtido de http://www.devcocast.eu/): 
V2KRNS10__20100501_NDVI__S-America.ZIP 

4.5. Análise dos dados 
Para avaliar a variação espacial da evapotranspiração usando o algoritmo SEBS, os dados de 02 de Maio de 2010 são 
analisados. Os dados primários foram baixados dos provedores GEONETCast-DevCoCast. Os outros produtos 
usados aqui foram também obtidos da internet (DEM, NDVI e LSA SAF) e de CDs com dados climatológicos de 
estações de superfícies brasileiros. Um fluxograma descrevendo os passos de (pré-) processamento do aplicativo é 
mostrado na figure 4.1. 

4.5.1. Passos de pré-processamento dos dados necessários 
Garanta que você descompactou o exercício e mova o navegador de ILWIS para o seu diretório de trabalho ativo. 
Você perceberá que há dois sub-diretorios, “gnc_data” e “lst”. O primeiro contém dados brutos de GEONETCast-
DevCoCast, o segundo contém uma base de dados de Temperatura da Superfície do Solo. Feche e reabra o ILWIS 
para garantir que as opções de diretório estão corretas. Você pode olhar os dados disponíveis nesta pasta, abrir 
alguns dos mapas e olhar o seu conteúdo.  
Agora, a partir do menu do ILWIS, garanta que o plug-in da caixa de ferramentas do GEONETCast esteja instalada, 
abra “Geonetcast” => “toolbox”, selecione a opção “Configuração” e “Pastas”. Agora selecione as opções de pasta 
para “SPOT VGT4 Latin America”, defina as pastas de entrada e saída apropriadas, note que a pasta de entrada é o 
seu diretório de trabalho ativo e adicione aqui o sub-diretório “\gnc_data”. Repita este procedimento e especifique a 
configuração apropriada da pasta para os produtos “SAF South America”. 
 

http://www.inmet.gov.br/
http://www.geominas.mg.gov.br/
https://landsaf.meteo.pt/
http://www.devcocast.eu/
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Figure 4.4 Fluxograma mostrando os passos principais para derivar a ET usando modelo SEBS no ILWIS e 
o  GEONETCast toolbox  

4.5.1.1. Importação de produtos LSA SAF  
Do menu principal de “GEONETCast” e “Toolbox” selecione “Satellite Application Facility (SAF)”, “South 
America” e “Albedo” para importar o produto de Albedo de Superfície. Digite a data apropriada obedecendo ao 
formato pré-definido “201005020000”. Repita estes passos para importar outros produtos SAF (DSSF, FVC, LAI e 
LST). Observe que, para importar a data de DSSF e LST o formato é “201005021500”. Verifique os dados 
importados resultantes, abra-e e passe sobre os mapas o cursor do mouse com o botão esquerdo pressionado. Como 
representação use “Pseudo”, para o albedo use DSSF, e para LAI, FVC e LST use respectivamente as representações 
“lai_SAF”, “fvc” e “lst”. Você notará que há muitos valores “sem dados” para o mapa “lst”, provavelmente devido à 
cobertura de nuvens. Como está é uma importante camada de entrada para o SEBS, atenção adicional precisa ser 
dada a este mapa. A resolução temporal deste produto é de 15 minutos e podemos processar séries de dados mais 
longas para obter um mapa de temperatura da superfície do solo melhor, usando mais “time stamps”. Para conduzir 
esta importação multi-temporal você aplicará uma rotina de “batch looping”. Para mais explicações sobre o processo 
veja Maathius et.al. (2011). Usando o navegador ILWIS vá para o subdiretório “\lst”, você verá vários “service 
objects” do ILWIS, usados para georeferenciamento. Feche o ILWIS a partir deste subdiretório. Com o Windows 
Explorer navegue para o subdiretório “\lst” e descompacte o arquivo “lst.zip”, usando a opção “extract here”. Uma 
vez completada esta operação, verifique o intervalo temporal dos dados de lst, note que o “time stamp” é em UTC 
(hora local = UTC – 3 horas)! Clique com o botão direito no arquivo “multi_lst_start.bat” e, do menu sensível a 
contexto selecione “Edit”. Inspecione a linha de comando “batch” fornecida e feche o arquivo. Agora selecione um 
segundo arquivo “batch”, chamado de “multiSame_1stimport.bat”, novamente selecione “Edit” do menu sensível a 
contexto. Agora modifique os “strings” de nomes de diretórios neste arquivo “batch” e especifique os caminhos 
corretos para a localização do ILWIS no seu sistema (veja as linas 7 a 9). Depois que o diretório correto tiver sido 
especificado para estas três linhas no arquivo “batch”, selecione dos editores de texto no menu principal as opções 
“File” e “Save”. Feche o editor de texto. Agora clique duas vezes com o seu mouse no primeiro arquivo de “batch” 
“multi_1st_start”. A importação multi-temporal do primeiro produto tem início e todos os arquivos SAF-1st são 
importados. Uma vez completa a rotina de “batch”, comece o ILWIS novamente e navegue ao subdiretório “\1st”. 
Abra um dos “1st” mapas importados e use como “Representation” “1st”. Agora você calculará a temperatura média 
da superfície do solo para este período de tempo. Para fazer isso, do menu principal do ILWIS selecione a opção 
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“File => Create => MapList” e adicione todos os mapas. Usando o ícone “>”, especifique um nome apropriado 
para a “Map List”, como “1st_time” e pressione “OK” para executar a operação. Primeiramente, todos os valores 
“no data” serão redefinidos como 0. Para isto selecione no menu principal do ILWIS a opção “Operations => 
Raster Operations => MapList Calculation”, como “map list” de entrada use “1st_time” (apenas 1 “map list” de 
entrada). Como “Expression” digite: 

ifundef(@1,0.00)  
Especifique como “map list” de saída “1st_time0” e pressione “Show”. Depois de terminados os cálculos, abra um 
dos novos mapas criados e verifique o resultado, todos os valores “no data” foram redefinidos como “0.00”. Clique 
com o botão direito no “map list” “1st_time0”, selecione do menu sensível a contexto a opção “Statistics => 
MapList Statistics”, como função estatística selecione “Sum” e especifique como nome do mapa de saída “1st_sum”, 
pressione “Show” para executar o comando. Repita este procedimento e selecione como função estatística a opção 
“Count”, mas agora use como mapa de entrada a série temporal original, chamada “1st_time”, chama o mapa de 
saída de “1st_count”. Note que este mapa dá o número de eventos que receberam um primeiro valor apropriado na 
série de dados temporais! Agora calcule a média “1st” digitando a seguinte expressão na linha de comando do 
ILWIS: 
 1st_avg:=1st_sum_1st_cont 
e use todas as opções “default”. Verifique esta mapa de saída. Clique com o botão direito do mouse no nome do 
mapa “1st_avg” e, do menu principal do ILWIS, selecione a opção “Edit => Copy Object to”, selecione a opção 
“Novo Diretório” e copie este arquivo para o seu diretório principal de trabalho ativo, usado para extrair todos os 
outros dados SAF. Use o navegador do ILWIS para voltar ao seu diretório de trabalho principal 

4.5.1.2. Importação de produtos de SPOT Vegetation 
Do menu principal de “GEONETCast” and “Toolbox” selecione “SPOT VGT4 Products”, “SPOT VGT4 Latin 
America”, e finalmente selecione “NDVI”. O formato de data a ser utilizado é “20100501”. Abra o mapa 
“ndvi20100501” e use como “Representation” “NDVI1”, passe o cursor do mouse sobre o mapa com o botão 
esquerdo pressionado e inspecione os valores. Note também que um mapa de status é criado. Este mapa será usado 
para selecionar apenas aqueles pixels que satisfazem os seguintes critérios: livre de nuvens, pixel terrestre e tendo boa 
radiometria nos canais do vermelho e do infra-vermelho. Para mais explicações sobre o procedimento, veja também 
Maathius et.al. (2011). Digite a seguinte formula de cálculo de mapa na linha de comando do menu principal do 
ILWIS: 

Status_ok:=iff((((ndvi20100501_SM div 1)mod 2)+(( ndvi20100501_SM div 2)mod 2)=0) and 
(((ndvi20100501_SM div 8)mod 2)+((ndvi20100501_SM div 32)mod 2)+((ndvi20100501_SM div 64)mod 
2)=3),1,0) 

Deixe todas as outras opções em “default” e execute a operação. Inspecione o mapa resultante e agora aplique a 
máscara, exibindo os pixels que satisfazem os critérios de seleção, ao mapa de NDVI, entrando com o seguinte texto 
na linha de comando do menu principal do ILWIS: 

ndvi_ok20100501:=iff(Status_ok=1,ndvi20100501,?) 
Novamente, use as opções “default” para todas as outras configurações e execute a operação, verifique os resultados, 
use como “Representation” “NDVI1”. 

4.5.1.3. Submapa de Minas Gerais e reamostragem de outros mapas 
Com o “ndvi_ok2010050” ativo e usando a opção ”Layer” adicione a opção “boundary”. Abra, do menu principal 
do ILWIS “Operations”, “Spatial Reference Operations”, “Raster” e “Sub Map”. Crie o sub mapa de Minas Gerais, usando 
as configurações da figure 4.2 (figura à esquerda).  
Para aplicar o SEBS, é importante que todos os mapas estejam na mesma projeção/sistema de coordenadas, mesmos 
dados e mesma resolução espacial. Reamostre todos os outros produtos importados usando a georeferência do Sub 
Mapa NDVI de Minas Gerais. Os mapas serão transformados para um sistema de coordenadas latlon, “Plate 
Carree”, latlon coordinate system, o dado WGS 84 e elipsóide e resolução espacial do produto de SPOT VGT4 
utilizado (aqui 0.0089285714, ou 112 pixels por grau). 
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Figura 4.2 Criando um  sub mapa do  SPOT VGT4 NDVI p/ o Est. de Minas Gerais e detalhes do sub map  
 
Para reamostrar os produtos LSA SAF e modelo de elevação digital GTOPO30_MINAS, siga as instruções abaixo: 
primeiro clique com o botão direito do mouse sobre o mapa que deseja reamostrar e escolha “Spatial Reference 
Operations => Resample”. Para definições de reamostragem selecione as especificações dadas na figura 4.3. Repita 
este procedimento para reamostrar também outros mapas, como Albedo, LST_avg, LAI, DSSF, FVC e 
GTOPO3o_minas. Aqui o prefixo para nome de arquivo usado para os mapas reamostrados de saída é “re_”. 

 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4.3 Configurações para a Reamostragem e o sub mapa resultante de Albedo  

4.5.1.4. Mudança de Unidades para LST e ALBEDO dos Sub Mapas de Minas Gerais 
Tome um cuidado especial com os passos a seguir, porque são necessários para rodar o SEBS e derivar a ET. As 
unidades de LST precisam ser trocadas de Celsius para Kelvin e, para o mapa de Albedo, de percentagem para razão. 
Para fazer isto, para o submapa de Minas Gerais (re_1st) digite a seguinte expressão ILWIS na linha de comando:  

re_lst_kelvin:=re_lst+273.15 
Mantenha todas as outras opções como “default” e pressione “OK” para executar a operação. Para mudar as 
unidades do submapa de Albedo (re_Albedo), de percentagem para razão, digite a seguinte expressão na linha de 
comando do ILWIS: 

re_albedo_ratio:=re_albedo*0.01 
Mantenha todas as outras opções em “default” e pressione “OK” para executar as operações. Verifique os resultados 
das operações. 
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4.5.1.5. Cálculo da Emissividade, Ângulo Zenital Solar e derive a radiação descendente 
Para calcular a emissividade, de acordo com o procedimento descrito em Valor e Caselles (1996), digite a seguinte 
expressão na linha de comando do ILWIS: 

re_emis:=0.985*re_fvc+0.96*(1-re_fvc)+0.015  
Mantenha as outras opções em “default” e pressione “OK” para executar as operações. Verifique o mapa resultante. 
Do menu principal do “GEONETCast” e “Toolbox” selecione a opção “Calculate MSG Angle”, “Calculate solar 
and satellite Zenith angle maps for MSG field of view” e digite, para o ano de 2010, “Month 05”, “Day 02” e hora 
“(UTM)=15.00”. Certifique-se de que o diretório de saída foi adequadamente atribuído! O mapa resultante, chamado 
de “sol_zenres”, deve ser reamostrado usando a georeferência do submapa de NDVI (ndvi_minas). Os seus 
resultados devem assemelhar-se aos da figura 4.4. 
 

Figure 4.4 Âgulo Solar Zenital do  MSG para o disco completapra o reamostrado para a georeferência  de 
Minas Gerais  

 

A radiação solar descendente pode ser espacialmente representada por um mapa, e.g. usando o produto DSSF, ou 
por um valor único. Nesse caso é derivado o valor único de 623 W/m2 sendo o valor meio obtido da estação 
meteorológica de superfície no estado de MG às 15:00h. dados obtidos de: 
http://sinda.crn2.inpe.br/PCD/historico/consulta_pcda.jsp). Observe que o horário UTC de 15 horas corresponde 
a 12 horas do horário local. 02 de maio corresponde ao número Juliano do dia 122 (soma dos dias de um dado ano, 
começando de 1º de janeiro: 31+28+31+30+2). Observe que você já importou e reamostrou previamente o produto 
DSSF! 

4.5.2. Importação de Tabela e processamento de dados in situ  
Do menu principal do ILWIS selecione “File => Import => ILWIS => Table => Space delimited”. Escolha como 
arquivo de entrada “Station_MG.txt” e “Station_MG” como arquivo de saída. Pressione “OK” e “Next” para 
continuar a importar dados, clique duas vezes e digite o nome apropriado de cada coluna, nas linhas da primeira 
coluna na janela “Edit column detail”: Y (coluna1), X (coluna2), Temp (coluna3), HumityRel (coluna4), Pressão  
(coluna5), Mix_ratio (coluna6), Ins_hrs (coluna7) e Windspeed (coluna8). Faça a edição de todos os nomes de 
colunas e pressione “OK” para importar a tabela. A janela “Edit column detail” é também dada na figura 4.5 e a tabela 
importada resultante é apresentada no apêndice 1. 

http://sinda.crn2.inpe.br/PCD/historico/consulta_pcda.jsp
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Figura 4.5 Editando a Primeira Coluna de  cada linha com o nome apropriado da coluna 
 
Selecione do menu principal do ILWIS “Operations => Table Operations => Table to point map”. Especifique 
configurações idênticas as dados no painel esquerdo da Figura 4.6 e pressione “Show”. Para ver o “point map” 
resultante com a distribuição das estações climatológicas de superfície do INMET, abra o “vector map” “boundary”, 
usando configurações padrão, selecione “Add layer” no menu da janela do mapa e selecione o “point map” 
“station_MG”. 
 

Figura 4.6 Tabela  para indicar a conversão de mapa e a distribuiçào de estações de terra do INMET  
 
Como pode ser visto na tabela importada mostrando observações climatológicas, quase não há diferença para as 
colunas “Ins_hrs” e “Mix_ratio”. O valor médio para estas variáveis seria uma boa aproximação para a área como 
um todo. Para as colunas “Windspeed”, “Pressure” e “Temp” ocorre uma variação maior. Isto pode ser representado 
espacialmente se houver uma correlação com a elevação.  
Para determinar se existe correlação, primeiro transforme o “point map” em formato raster, clique com o botão 
direito na “station_MG” do point map, selecione, do menu sensível a contexto, a opção “Rasterize => Point Map to 
Raster”, use como georeferencia “NDVI_Minas” e deixe as outras opções na configuração padrão fornecida, 
pressione “Show” e “OK”. Olhe com cuidado, se necessário amplie o local, já que as estações são representadas por 
um único pixel! O próximo passo é cruzar as informações do “point map” com o modelo de elevação, neste caso o 
GTOPO30 DEM reamostrado (veja novamente a seção 4.5.1.3), aqui chamado “re_gtopo30”. 
Selecione do menu principal do ILWIS “Operations => Raster Operations => Cross”, como primeiro mapa 
selecione “re_topo30” e como segundo, selecione do mapa “station_MG”, pressionando o sinal de “+” a frente do 
mapa, a coluna “Temp”. Como tabela de saída especifique “dem_temp” e pressione “Show”. Abra a tabela do menu 
de tabela ativo, selecione “Columns => Statistics” e selecione a função “Correlation”, note a atribuição da coluna e 
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pressione “OK”. Note que há uma correlação considerável entre as variáveis de elevação e temperatura (R=.757). Do 
menu da tabela selecione “Column”, “Least Squares”, para a coluna X selecione “re_gtopo30”  e para a coluna Y 
selecione “map2” (representando a variável Temp), especifique como saída a coluna “dem2temp”. Use como função 
“polynomial”, como “Nr. Of terms” selecione “2” e pressione “OK” para executar a operação. Na janela de 
propriedades da coluna selecione a opção “Additional Info”, aqui é dada a função que precisa ser usada 
posteriormente para transformar o mapa de elevação para temperatura. Anote a equação e pressione “OK” para 
fechar a janela, deixando as demais opções na sua configuração padrão, pressione “OK”. Uma nova coluna, chamada 
“dem2temp” é agora adicionada à tabela. Verifique os resultados obtidos na tabela. Repita o procedimento para obter 
a relacao entre o modelo de elevacao gtopo_30 e verifique a nova coluna “pressure” da tabela “station_MG”.  
Transforme o modelo de elevação re-gtopo30 em temperatura do ar (em graus Celsius) e altura de referência de 
pressão (uma altura de + 2 metros é usada em SEBS, em PA) usando as equações a seguir (que você derivou nos 
passos anteriores) digitando as expressões na linha de comando do ILWIS: 
 re_air_temperature:=24.096+-0.006*re_gtopo30 
Mantenha todas as outras opções na sua configuração padrão e pressione “OK” para executar a operação. Repita a 
operação para derivar a “pressão de referência” digitando a expressão a seguir na linha de comando do ILWIS: 
 re_pressure_reference:=100355.628+-9.175*re_gtopo30 
Mantenha todas as outras opções na configuração padrão e pressione “OK” para executar a operação. Para derivar a 
pressão à superfície usa-se uma temperatura média diária do ar de 20 graus Celsius, correspondendo a um aumento 
de pressão de 23 Pa para uma diferença de 2 metros, já que é assumida uma Altura de Referência de 2 metros 
durante a coleta dos dados de campo. Para obter a pressão à superfície digite a seguinte expressão na linha de 
comando do ILWIS: 

re_pressure_surface:=re_pressure_reference+23  
Mantenha todas as outras opções na sua configuração padrão e pressione “OK” para executar a operação. Verifique 
os resultados obtidos, usando “Pseudo” como representação.  
Para obter uma representação espacial da velocidade do vento é necessária outra abordagem, já que não há correlação 
com o modelo de elevação. Selecione do menu ILWIS a opção “Operations => Interpolation => Point 
Interpolation => Moving Average”. Escolha a coluna “windspeed” do “point map” “Station_MG” (pressione o sinal 
de “+” em frente ao mapa de pontos e selecione a coluna apropriada), use a opção “Inverse Distance” como 
“Weight Function”, mantenha a opção padrão “Weight Exponent” como “1” e selecione a opção “Use Spherical 
Distance”. Especifique como “Output Raster Map” “re_windspeed” e selecione a georeferência “ndvi_minas”, 
pressione “Show” para executar a operação. Verifique os resultados obtidos, use “Pseudo” como representação. 
Corrija o mapa de velocidade do vento obtido para representar esta velocidade à superfície usando o fator de 
correção. Digite a seguinte expressão do ILWIS na linha de comando: 
 Re_windspeed_cor:=re_windspeed*0.75 
Mantenha todas as demais opções na sua configuração padrão e pressione “OK” para executar a operação. Verifique 
os resultados obtidos, use a representação “Pseudo”. 

4.6. Executando o SEBS no ILWIS 
Depois de todo este pré-processamento você agora pode executar o SEBS. Selecione “Operations”, “SEBS Tools” e 
“SEBS” do menu principal do ILWIS. Veja também a figura 4.7, indicando todos os mapas de entrada necessários 
para rodar o “plug-in” do SEBS. Certifique-se de que todos os mapas de entrada estão corretamente especificados, 
assim como os valores individuais que representam os diversos parâmetros do modelo. Note que você pode executar 
o SEBS duas vezes, a primeira com um valor de “Instantaneous Downward Solar Radiation Value” de “623 W/m2” 
and for a second run, active the check box in from the “Inst. Downward Solar Radiation Map (W/m2 )” e a segunda 
usando como entrada o mapa DSSF reamostrado, aqui chamado de “re-dssf”. A Figura 4.8 mostra os resultados 
diários de evapotranspiração do SEBS em mm/dia para ambas as rodadas. 
Uma vez que o SEBS tenha terminado os seus cálculos, selecione o mapa “SEBS_Daily_Evap”, quando o SEBS for 
iniciado novamente um novo mapa diário de evaporação será produzido, chamado “SEBS_Daily_Evap__1”. A linha 
de comando do SEBS pode ser obtida do histórico destas linhas de comando, pressionando-se o botão 
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correspondente. A linha de comando dado como exemplo abaixo é resultado das especificações dadas no formulário 
de entrada exibido na figura 4.7. Se pequenas modificações precisarem ser implementadas, os parâmetros podem ser 
facilmente substituídos na própria linha de comando, sem que seja necessário preencher todo o formulário: 
 

sebs.mpr=MapSEBS(re_lst_kelvin,re_emis,re_albedo_ratio,ndvi_minas,1,re_lai,1,re_fvc,1,re_solzen,0,1,re_ 
gtopo30,0,1,122,0,0,0,2,1000,0,,0.0109,1,Re_windspeed_cor,2,1,re_air_temperature,25,1,re_pressure_refere
nce,100000,1,re_pressure_surface,100100,39.2,1,623,0,nomap,0,nomap,0,nomap,0,nomap,0,,20,0,,7) 

 
Note que, para a umidade específica, foi utilizado o valor médio da coluna “Mix_ratio”, da tabela “station_MG” e 
aplicada a seguinte equação: umidade específica em kg/kg = mix_ratio/(1+mix_ratio), ou 0.011/(1+0.011). O valor 
médio de horas diárias de insolação é extraído dos dados climatológicos apresentados na tabela “station_MG”, sendo 
aproximadamente 7 horas. KB^-1 é o número de Stanton invertido, um coeficiente adimensional de transferência de 
calor, e pode ser mantido no valor padrão. Exiba os seus resultados SEBS usando a representação “sebs_ET” 
disponível no seu diretório de trabalho principal. Os seus resultados devem corresponder aos dados na Figura 4.8 
abaixo. Inspecione os seus valores diários de ET obtidos (em unidades de mm/dia). 
 

 Figura 4.7 Tela de entrada de dados do SEBS no ILWIS  

Figura 4.8 SEBS  ET diário (mm/dia), usando  único valor de radiação solar  descedente (à esquerda) e 
mapa LSA SAF DSSF (à direita) 
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4.7. Derivação de informações estatísticas agregando o estado de Minas Gerais e área pivô 
central 

Agora você usará o os resultados de evapotranspiração diária do SEBS (sebs_daily_evap) para extrair a informação 
para todo o estado de Minas Gerais e para cada área pivô central. Para obter as informações para o estado de Minas 
apenas exiba primeiramente o mapa “SEBS_Daily_Evap” e adicione a camada vetorial (vector layer) “boundary”. 
Nas opções de exibição de “add layer” deselecione a opção “Info” e ative a opção “Boundaries only”. 
Converta o arquivo de polígono “boundary” a um formato raster selecionando do menu principal do ILWIS as 
opções “Operations => Rasterize => Polygon to raster”. Na janela “Polygon to raster selecione a camada vetorial 
“boundary” e selecione a georeferência “NDVI_Minas”. Como mapa de saída digite “boundary” e pressione “Show” 
e em seguida “OK”, para ver o recém criado mapa raster “boundary”. 
Agora mascare os dois mapas de ET criados com o SEBS usando o mapa raster “boundary”. Digite a seguinte 
expressão na linha de comando do ILWIS: 

sebs1_mask:= iff(boundary="1",sebs_daily_evap,?) 
sebs2_mask:= iff(boundary="1",sebs_daily_evap__1,?) 

Mantenha todas as outras opções nas suas configurações padrão e pressione “OK” para executar a informação. 
Verifique os resultados obtidos, use a representação “sebs_ET”. Para obter algumas estatísticas gerais, clique com o 
botão direito no mapa “sebs1_mask” e selecione do menu sensível a contexto as opções “Statistics => Histogram” e 
pressione “Show”. Repita o procedimento também para o mapa “sebs2_mask” e verifique e compare os seus 
resultados.  
Outra forma de obter resultados estatísticos é classificar o intervalo contínuo de dados em classes definidas pelo 
usuário. Para isto um domínio é utilizado. Clique duas vezes no domínio “sebs_cl” e tome nota das classes que 
definidas. Do menu principal do ILWIS selecione a opção “Operations => Image Processing => Slicing” e 
especifique como mapa raster “sebs1_mask” e como mapa raster de saída “sebs1_mask_cl” e selecione do menu 
sensível a contexto as opções “Statistics => Histogram” e pressione “Show”.  
Repita o procedimento de classificação também para o mapa “sebs2_mask”, verifique e compare os resultados.  
Para obter as informações de ET para cada pivô central, é disponibilizado um mapa de polígonos “pivots_MG”. Em 
primeiro lugar exiba o mapa vetorial “boundary” e adicione as camadas “pivots_MG” e “municip”, veja também a 
figura 4.9. Converta o mapa poligonal “pivots_MG” ao formato raster, selecione no menu principal do ILWIS 
“Operations => Rasterize => Polygon to Raster”. Como nome do raster de saída, digite “pivots_MG” e como 
georeferência use “ndvi_minas”.  
 

Figura 4.9 Detalhe de Mapa mostrando várias camadas de vectores de areas irrigadas por pivôs centrais  
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Para obtem uma tabela com resultados estatístisticos por pivô, selecione “Cross” (do menu principal do ILWIS 
selecione “Operations => Raster Operations”) e use o mapa raster “pivots_MG” e o mapa diário de 
evapotranspiração do SEBS, aqui chamado “sebs_daily_evap”. Especifique “pivots” como primeiro mapa raster e 
“sebs_daily_evap” como segundo. Especifique “sebs_pivots” como tabela cruzada de saída. Mantenha as outras 
opções na sua configuração “default”. Em seguida agregue a evapotranspiração diária do SEBS como uma nova 
coluna na tabela “pivots_MG”. Para isto, selecione a opção “Column” do menu da tabela “sebs_pivots” e da “drop 
down list” selecione “Aggregation”. Especifique as configurações de acordo com a figura 4.10. 

Figura 4.10 Agregando a evapotranspiração diária do SEBS para os pivôs centrais  
 
Exiba o mapa raster, disponibilizado no seu diretório principal de trabalho, ET_Minas_geo, usando a representação 
“Pseudo”. Este mapa foi obtido do, assim chamado, produto-ET do LSA SAF.  A resolução temporal deste  produto 
é de 30 minutos, de forma que 48 passos no tempo foram agregados para obter o mapa diário de ET, o que é similar 
à forma como foi criado o mapa LST. Um sub mapa apropriado foi feito.  
O mesmo método usado para obter resultados estatísticos do SEBS pode ser aplicado ao mapa ET LSA SAF, 
chamado “ET_Minas_geo”. Do menu principal do ILWIS selecione “Operations => Raster Operations”, selecione a 
função “Cross”, especifique “pivots_MG” como primeiro mapa raster e “ET_Minas_geo” como segundo. 
Especifique “saf_ET_pivots” como tabela cruzada de saída. Agora agregue a evapotranspiração diária, coluna 
“ET_MINAS_geo”, à tabela “pivots_MG”, chamando a coluna de “avg_et_saf”. Para isto selecione “Column” no 
menu de tabela e, da lista “drop down” , selecione a função “Aggregation”, especifique “avg_et_saf” como coluna de 
saída, “pivots_MG” como tabela de saída, pressione “OK” para executar a operação. Abra a tabela “pivots_MG” e 
inspecione as duas colunas recém adicionadas. Digite a seguinte expressão na linha de comandos da tabela:  

difference:=avg_sebs-avg_et_saf 
Mantenha as outras opções em default, pressione “OK” para executar a operação, e verifique os resultados obtidos. 

4.8. Conclusões 
O modelo SEBS foi usado para estimar a evapotranspiração diária para o dia 2 de maio de 2010. Os resultados 
mostram valores de ET variando entre 2.063 e 4.321 mm/dia em Minas Gerais, usando um único valor instataneo de 
radiação solar descendente e valores de ET estimados entre 2.633 e 4.560 mm/day, com o produto LSA SAF DSSF 
(usando 0.5 % de intervalo de cutoff ). Estatísticas mais detalhadas, como a média, o desvio padrão e a mediana, 
revelam que os resultados, de forma geral, são bastante comparáveis, a pesar de a última estimativa de ET ser 
ligeiramento maior, já que um única imagem, correspondente ao meio dia (hora local) foi usada. Os produtos diários  
agregados ET LSA SAF dão valores de ET na faixa entre 0.01 e 4.21 mm/dia, mostrando uma diferença ainda maior 
entre a estimativa SEBS (nas duas rodadas) e a obtida de LSA SAF.  Lembrando que, nas rodadas do modelo SEBS, 
foram usados muitos dados climatológicos-meteorológicos in situ, consideramos as estimativas de ET derivadas 
deste modelo mais realistas do que as do LSA SAF.  Consideramos também que esta última subestima ligeiramente 
ET. Mais validações são necessárias, usando observações in situ de ET. É importante considerar que várias camadas 
de entrada do modelo SEBS são derivadas dos produtos LSA SAF,  e são também usadas no cálculo do produto ET 
LSA SAF. 
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APPENDIX 1 
Tabela com dados  “in-situ” de estações metgeorológicas de superfície  para Minas Gerais. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 


